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Software Compatibility 
 

For use with TDS software Version 2.X.X and works with all versions of NorTronic® Tool software 2.14 
onwards. 
 
NOTE:  ‘X.X’ is shown in place of the latest software release version # i.e. 2.0.14. 

 
 

Introduction 
 
The Torque Data System (TDS) is PC software designed with a user-friendly interface that will enable data 
archiving from NorTronic® electronic torque wrenches. 
 
TDS uses a bi-directional USB or Wireless interface to download Targets, Tool Setup and Tool Lock to the 
NorTronic® and retrieve Stored Readings and Tool Setup from the NorTronic®. The wireless interface 
requires the use of an additional USB wireless adapter plugged into a USB port on your PC. 
 
TDS gives the ability to archive data when Torque Tools are being used in tightening applications (Work). 
Statistical Process Control (SPC) can also be performed on the archived data as well as the ability to view 
histograms of the archived data. 
 
Torque, Torque and Angle graphs can be viewed in TDS and printed. 
 
Data can be exported to Microsoft® Excel® and/or any other equivalent packages via the Clipboard.  
 
Part numbers covered by this manual; 37781, Torque Data System (TDS). 
 

 

Features and Functions 
 

• USB interface to Norbar NorTronic® electronic torque wrenches for fast data transfer. 

• Wireless interface to Norbar NorTronic® electronic torque wrenches for fast data transfer with additional 
Wireless adapter. 

• Data Base for archiving of data which has been stored on the NorTronic® or sent to the “Receive 
Results” window from NorTronic®. 

• Statistical Process Control (SPC) on Test Results for Tools. 

• Set up individual (or multiple) NorTronic® Tools with Targets and Tool Set Up options via USB or 
Wireless using the synchronisation options. 

• Send up to 15 sequential or non-sequential Targets to a NorTronic® Tool. 

• Ability to download a LOCK to the NorTronic® to stop user adjustment. 

• Real time data input via the Receive Results window. 

• Real time graph creation from a USB connected Tool. 

• Export of Real Time Graph Data in CSV format. 

• Create a Report from stored results. 

• Ability to set and send a Torque + Angle with Final Torque Target. 

• Ability to set and send an Audit Target. 

• Shortcut icon to TDS operator’s manual. 

• Show Last time of Tool calibration. 

• Compatible with Windows® 7, 8.1 & 10 (32 bit & 64 bit). 
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Installing TDS 
 

The software is supplied as an installation file on a USB Flash Drive (memory stick). This is included with the 
NorTronic® Torque Wrench. 
 

 
WARNING: Before installing TDS you will need to un-install any previous versions. 

See page 65 for un-install instructions. 
 

 
TIP:  Backup your old database before uninstalling your old version of TDS. Use the restore 

database option after your new version of TDS has been installed. See page 60. 
 

Plug the USB Flash Drive into your PC.  
 
Go to START – MY COMPUTER and double click on Removable Disk (?). 

 

 
 
 

NOTE:  The user may need administrative privileges to be able to install the software. 
 
Double click on SetupTDS2XX (where XX represents the latest software revision number) or copy the file to 
a directory on your computer and double click on it. 
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Windows® 7, 8.1 &10 
 

 
 

Click on Next. 
 

 
 
 
Read the Licence agreement and click on I accept the agreement if you wish to proceed, then click on 
Next. 
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NOTE:  For 32 bit versions the destination location will be C:\Program Files\Norbar\TDS. 
 
Change location and / or click on Next. 
 

 
 
Change the folder name and / or click on Next.  
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NOTE:  For 32 bit versions the destination location will be C:\Program Files\Norbar\TDS. 
 
Click on Install to install TDS onto your computer.  
 

 
 
Click on Install to install USB driver onto your computer. 
 

 
 
Click on Install to install Wireless Adapter driver onto your computer.  
  



 

 8 

 

 
 
Click on Finish to complete the installation. 
 
After Installation a TDS icon will be placed on the desktop. 
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Connecting a NorTronic® Tool to TDS 
 
1) Start TDS by double clicking on the desktop icon.  
 

 
 
 
 
 

The Initialising TDS message box will be shown. Wait 
until initialization has finished. 

 
 

 
 
 
 
 
 
 

Screen shown on power up 
with Sample Department 
and Tools added. TDS also 
creates an ‘Unknown’ 
department, which is 
where new Tools will be 
added (unless specified 
differently). 

 
 

 
 

 
 

NOTE:  TDS comes with a Sample Department & Sample Tool already created. These are for 
information only and should be deleted when not required. 

 
TIP:  Delete or rename the Sample department if not required.  

 
 

2) Plug in the USB cable (part # 39678 supplied with 
NorTronic®) between the mini USB connector on the 
side of the NorTronic® and the USB Type A 
connector on a PC.  

 
NOTE:  The user may need to remove the USB 

cover from the NorTronic® to achieve 
this. The USB cover must be fitted for 
IP44 protection. 

  
USB connector 
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Alternatively plug in the Wireless adapter (part # 39671 - 868 MHz or part # 
39672 - 915 MHz) into a USB port on your PC. 
 
 
Before NorTronic® is connected, the bottom 
left of the TDS window will show: 

 
3) Power up the NorTronic® by pressing any button. 

 
4) Wait for the USB or Wireless icon to appear in green on the NorTronic® display.                         
 

When TDS successfully connects to a NorTronic®, the bottom 
left of the TDS window will show:  
 
 

 
NOTE:  The number in the brackets is the serial # of the NorTronic® Tool connected. 

 
5) Click on “Synchronise Now” to 

transfer data. 
 

 
 
 
 
 

The following message will be displayed when 
connection is established and data is being 
transferred. 

 
 

NOTE:  No data will be shown if none has been 
previously saved for the connected 
NorTronic® Tool. 

 
 

When you connect and synchronise NorTronic® for the 1st time, TDS creates an ‘unknown’ department. 
Rename as required. 

 
 

Disconnecting a NorTronic® Tool from TDS 
 

For some configurations of PC hardware and software it may be necessary to disconnect from USB correctly 
before removing the lead. Click on ‘Safely Remove Hardware’ in the bottom right hand corner of your 
desktop if this option is available to you.  
 
Unplug USB lead from either the NorTronic® or PC and TDS will 
display after a number of seconds: 
 
 
NOTE:  Wait at least 10 seconds before re-inserting the lead if required. 
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Departments (Customers) 
 

Rename Departments 
 

Departments can be renamed to anything you choose, but this has 
been primarily designed to be customers. Use Departments for a 
single Factory environment and use Customers for a Calibration 
lab environment. 

 
1)  Right click on the Departments icon. 
 
2)  Click on Rename Departments. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3)  Enter required text and click OK. 
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Add Department (Customer) 
 

1) Right click on the Departments (Customers) icon to show the drop down menu.  
 
2)  Click on Add Department (Add Customer) from the drop down menu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3) Type in your required Department (Customer) name or identification and press Return. 
 
 
 
 
 
 
 
 
 
 
 

TIP:  Departments (Customers) can also be added by right clicking on an existing Department 
(Customers) icon and selecting Add Department (Add Customer) from the drop down menu. 
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Rename Department (Rename Customer) 
 

1)  Right click on the required Department (Customer) you wish to rename, and then click on Rename 
Department (Rename Customer) on the drop down menu.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2)  Type in the new Department (Customer) name or identification and press return. 
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Delete Department (Delete Customer) 
 

1)  Right click on the required Department (Customer) you wish to delete. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2)  Click on Delete Department (Delete Customer) on the drop down menu. 
 
If a Department (Customer) has Tools & data associated with it, you will see the following message.  

 

 
 

 
Click on the required option Yes, No or Cancel as required. 
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Tools 
 
Adding a Tool to a Department (Customer) 
 
This is done automatically when TDS detects a new Tool via USB or 
Wireless. Alternatively, click on the short cut icon        on the TDS 
Toolbar to manually Add a Tool.  

 
 
 
 
 
 
 

TIP:  Tools and their associated data can be moved between departments (Customers) by 
clicking on the Tool and holding down the left hand mouse button and dragging from one 
department (customer) to another, then releasing the left hand mouse button. 

 
 

Expand the Departments (Customers) tree and right Click 
on the required Tool and select the required option from 
the drop down menu.  

 
 

 
All data for a Tool is stored under the Tool Serial # and 
then sub divided into Work ID’s. Test Results saved on a 
Tool are transferred to TDS when you synchronize with the 
Tool. Test Results can be sent to TDS (and saved) in real 
time using the Receive results option. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

TIP:  Only Tools that are connected will show all the options. Connected Tools are shown in blue 
and Tools that are not, are shown in black in the tree structure. 
 

 
 
 
 
 
 
 
 
 
 
 

TIP:  Capture Graph is only available for USB connected Tools. 
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Delete Tool 
 
1) Right click on a Tool you wish to Delete to 

select that Tool. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
2) Click on Delete Tool to show the screen below. 

 
 
3) Click on Yes, No or Cancel as required. 
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Find 
 
1) Right click on a Department in the left hand tree structure, and 

then click on Find on the drop down. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

2) Enter the Tool Serial Number and click on OK. 
 

 
 
 
 
 
 
 

 
3) The required Tool will be highlighted in the left hand tree 

structure. 
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Targets 
 
Up to 15 Targets linked (or non-linked) Targets can be sent to any one Tool at any time. 
 
There are 4 Target configurations: - 
Torque Target,  
Snug Torque followed by Angle Target,  
Snug Torque followed by Angle Target + final Torque Target 
Audit Torque Target. 

Torque, Snug Torque followed by Angle and Snug Torque followed by Angle Target + final Torque Targets 
all have upper and lower limits. Audit Targets do not have Upper and Lower Limits and use absolute values. 
 
To obtain SPC data on a Work ID, a Target must be in use when the Test Results are being saved on the 
Tool or sent to TDS via the Receive Results option. 
 
• Linked Targets can only be set up in TDS.  

NOTE:  This option allows a tightening sequence to be performed. 
• The # of Tests & Next Target can only be specified in the TDS software target.  

NOTE:  This option allows a tightening sequence to be performed. 
• Linked Targets can be sent via USB or wirelessly to the Tool. 
• If the save button has been pressed on NorTronic® (manual or auto reset mode), results will be saved to 

the Tools internal memory. The results are transferred to TDS when the Tool is synchronized via USB or 
Wireless. 

• If the save button has not been pressed on NorTronic® (manual or auto reset mode), results will be 
wirelessly transmitted in real time back to the TDS software and shown in the “Receive Results” window.  

• If after the final Target has completed (and No further Target has been specified), the last Target remains 
active. 

• To carry on, link the last Target to the first. 
 

1) Click on the Define tab on the main title bar and then click on 
Targets. Alternatively click on the short cut icon      on the TDS 
Toolbar. 

 
 

 
 
 
 
 
 
 

2) Right click on the right-hand pane to show 
the screen below. Note: to Modify, Delete 
or Duplicate a Target, you need to right 
click on the required Target. 

 
 

 
 

 
3) Click on required options. See relevant section for more detail. 
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Add Target 
 
Target Set up flow diagram 
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1) Click on the Define tab to show the drop down on the main title bar and then click on Targets. 

Alternatively, click on the short cut icon       on the TDS Toolbar. 
 
 

2) Right click in the Targets pane to show the drop-
down menu, then click Add Target.  

 
 
 
 
 
3) Check the cursor is blinking in the 

Name entry box and Type required 
text. 
 

4) Click in the Description entry box 
and type the required text. 
 

5) Click on the 
Torque units 
drop down 
and click on 
the desired 
units.  

 
 
 
 
 
 
 
 

6) Enter values for ‘Target, Upper Limit % (No decimal places i.e. 4). This is the Torque Upper Limit as a 
percentage of the Target value., lower Limit % (No decimal places i.e. 4). This is the Torque Upper 
Limit as a percentage of the Target value. 
 
 

7) Click the Angle ? Tick box if 
required.  
 

8) Enter values for ‘Target Torque, 
Angle Target, Upper ° This is the 
Angle Upper Limit and is in degrees 
(No decimal places i.e. 3), lower ° 
This is the Angle Lower Limit and is 
in degrees (No decimal places i.e. 
3) and Final Target (if required). 
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9) Click the Audit Mode ? Tick box if 

required. Options after this will be 
greyed out if not ticked. Enter 
values for ‘Audit Target, Angle 
Limit, 
 
 
 

10) Click in the Upper entry box and 
type the required value. This is the 
Angle Upper Limit and is in degrees 
(No decimal places i.e. 4). 
 
 

 
11) Click in the Lower entry box and 

type the required value. This is the 
Angle Lower Limit and is in degrees 
(No decimal places i.e. 4). 

 
 

 
12) Click in the Number of Readings entry box and type the value if required. Here is where you can define 

the number of tests to be taken for the Target value. 
 

13) Click on the Next Target drop down and select the required Target from the list. 
 
14) Click OK to save the Target in TDS. 
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Modify Target 
 
1) Click on the Define drop down on the main title bar and then click on Targets. Alternatively, click on the 

short cut icon      on the TDS Toolbar. 
 

2) Right click on the Target you wish to modify in the Target pane and click on Modify  
 

 
 

3) Target to show the ‘Modify Target’ screen. 
 

 
 
 

4) See Add Target on page 19 for more information. 
 

5) Make necessary changes and click OK 
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Delete Target 
 

1) Click on the Define drop down on the main title bar and then click on Targets. Alternatively, click on the 
short cut icon      on the TDS Toolbar. 
 

2) Right click on the Target you wish to delete in the right hand pane.  
 

 
 
3) The following screen will be shown, click on Yes, No or Cancel as required. 
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Duplicate Target 
 

1) Click on the Define drop down on the main title bar and then click on Targets. Alternatively, click on the 
short cut icon      on the TDS Toolbar. 
 

2) Right click on the Target you wish to 
Duplicate in the Target pane and click on 
Duplicate Target to show the ‘Add Target’ 
screen. 

 
 
 
 
 
 
 
 
3) Change Name of Target and 

Target value, then click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
4) The new target will now be shown in the Targets pane. 
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Send Target 
 

Send Target overwrites any Target(s) stored on the NorTronic® with the highlighted Target(s) in TDS. 
 
This option is only active when ‘? Tool is present (xxxxxxxx)’ is 
shown in the bottom left hand corner of TDS after connecting to a 
NorTronic® tool(s) via USB or Wireless.  
 
 
This option can be used to control the Target(s) sent to single or multiple NorTronic® Tools. 

 
 

1) Click on the Define drop down on the main title bar and then click on Targets. Alternatively, click on the 
short cut icon      on the TDS Toolbar. 
 

 
 
 

2) Click on the Target or Targets you 
wish to send in the Targets pane to 
show the drop down. Click on Send 
Target. 

 
 

 
NOTE:  If no Tool is connected, 

Send Target will be 
greyed out. 

 
 
 

Alternatively, click the Send Targets icon       
on the TDS Toolbar.  
 

 
 
 
 
 
 

TIP:  Selecting Multiple Targets will send these Targets as Non-Linked Targets (even if they 
are Linked in TDS). 
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TIP:  To send a Linked sequence of Targets, select the first one in the sequence. TDS will 
prompt you with what Targets are being sent. 

 

 
 

3) Select which Tool you wish to 
send the Target to. Only one will 
be shown if there is only one 
awake and connected. 

 
 
 
 
 
 
 
 

 
 

4) Enter a Work ID, if one is 
required. See page 27 for more 
information.  

 
 
 

NOTE:  When a new Target 
or Targets are sent 
to the Tool, any 
existing Target(s) & 
Work ID will be 
replaced with the 
one’s you are 
sending. 

 
 
 

5) When the Tool has received the Target or Targets, a 
confirmation pop up screen will be shown. The Target or 
Targets are now active and the Tool can be used. 
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Work ID 
 

• A Work ID is a name of a collection of Test Results done on an application e.g. Axle 1. 

• This can be user definable, Alpha / numeric when entered into TDS and downloaded to the Tool. 

• Maximum number of Alpha / numeric characters limited to 16. 

• The Work ID is not editable on the Tool (and cannot be seen). 

• Data is saved under “Tool Serial #” → “Work ID’s” in TDS. 

• Statistical Process Control (SPC) can also be performed on the archived Test Results as well as the 
ability to view histograms of the archived data. 
 
 

View Work ID Test Results 
 

1) Expand the tree structure under a Tool by right clicking the + in front of the Tool. 

2) Click the + in front of Work ID. 

3) Right click on the desired Work ID. 

4) Click on View from the drop down menu. The Test Results will be shown in the right-hand pane. 
 

 
 

NOTE:  Results are shown in Red (Fail) when they are outside of Target Limits. 
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List Tools for a Work ID 
 

1) Click Define tab, then click List Tools for Work ID. 
 
 
 
 
 
 
 

2) Type in the Work ID you are looking for, then click 
OK.  

 
 
 
 
 
 
 
 
 

 
3) Double click on the Work ID which will be highlighted in the right hand pane. 

 

 
 

4) You can then double click on the Work ID (in the left-hand tree), to view the results in the right-hand 
pane. 
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Results 
 

Stored Results on NorTronic® Tools can be sent to TDS by pressing the  button on the Toolbar. The Tool 
must be connected to TDS which is shown in the bottom left hand corner of TDS. See page 59 for 
Synchronization Options. 
 
Alternatively, send the Results in real time using Receive Results (see below). 

 
  

Receive Results 
 

Test Results can be sent from the NorTronic® Tool to TDS (in real time) via the Receive Results option.  
 
 

1) Right Click on the connected Tool (shown in 
blue) to show the drop-down menu. click on 
Receive Results. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2) Alternatively, Click the Options tab to show the drop-
down and click Receive Results. 
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3) Select the Tool you require in the Receive from drop-down (if multiple Tools are connected), followed 
by clicking Start.  
 

 
 
 

4) The USB or Wireless Icon on the NorTronic® Tool will go orange                               indicating you are in 
Receive Results mode.  
 

5) Send your Test Results into the Receive Results window. If a Work ID was sent to the Tool with the 
Target(s), this is displayed at the bottom. 
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6) If you wish to set a Work ID, type your text in the Work ID box and click Set. 
 

 
7) To save the Test Results in TDS, click Save Results. If the user clicks Done, the Test Results are not 

saved and you will see the following screen. 
 

 
 

8) Click Yes, No or Cancel as required. 
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Moving Results 
 

Highlighted Results can be moved from one Work ID to another by Right 
clicking and using Cut & Paste from the drop-down.  
 
 
Highlighted Results can also be copied from one Work ID to another by 
Right clicking and using Copy & Paste from the drop-down. 
 

 
 
 
 
 
 
 
 

 
Printing Results 
 
Highlighted Results can be sent to a Printer by clicking the 
Print option on the drop-down. 
 

 

 
 
 
Deleting Results 
 
Highlighted Results can be permanently deleted by clicking the 
Delete option on the drop-down. 
 
You will see the following pop up.  

 

 
 

Click Yes, No or Cancel as required. 
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Assign Target Name 
 
The Name of a Target can be added to the Results View and the Report. This is only possible if the Target 
exists in TDS. 
 
1) Create Target in TDS with a name (in this case, 

“T+A NoLink”). 
 
 
 
 
 
 
 
 
 

2) Send the Target to the 
Tool and take some 
Results with the Target. 
Transfer the results to 
TDS and open the Work 
ID (in this case “NEW 
WORK ID”). 

 
3) Select (highlight) the Results 

you wish to add the Target 
name to. Right click on the 
Results and select ‘Assign 
Target Name’ on the drop-
down menu. 
 

 

 

 

 

 

 

 

 

 

 

 

4) Select the required Target from the drop-down and click 
‘OK’. 
 
 
 
 
 
 
 
 
 
 
 

5) The Target Name will now 
be shown with Target in 
the Results View. 
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6) The Target name will 

also be added to the 
Report (see page 46 
for details on how to 
create a Report). 
 

 
 
 
 
 
 
 
 
 
Unassign Target Name 
 
1) Select (highlight) the 

Results you wish to 
remove the Target name 
from. Right click on the 
Results and select 
‘Unassign Target Name’ 
on the drop-down menu. 
 
 
 
 
 
 
 
 
 
 
 
 

2) Target name has now 
been removed. 
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Change Work ID 
 
1) Select (highlight) the 

Results you wish to 
change the Work ID 
name. Right click on 
the Results and 
select ‘Change Work 
ID’ on the drop-down 
menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2) Type in the new Work ID and click ‘OK;. 
 
 
 
 
 
 
 
 

3) A new Work ID (in this case “New Name”), will be created under the same Tool in the tree. Double click 
on the new Work ID in the tree to view the results. 
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Refresh 
 

Click the Refresh icon  on the Toolbar or select 
Refresh from the View drop-down menu to re-draw 
the current display.  

 
 
 
 
 

Reset column sizes 
 

Use this function to re-size all columns to fit the text 
in the Results view.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
Find 
 
Use this feature the Find text within the Results 
view 
 
To keep searching for the same entry, press ‘F3’ 
on your keyboard to ‘Find Next’. 
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Coloured Background 
 

The Results view background can be 
either white or coloured. This can be 
changed by Right clicking in the 
Results view and selecting Coloured 
Background form the drop-down. 

 
This is Work ID specific. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Colours 
 

With Coloured Background selected (ticked), the user can 
choose which colours are used by clicking on Colour 1 and 
Colour 2. 

 
 
 
 
 

Choose the colours required, then click ‘OK’. 
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View Statistics 
 
1) Right click on a work ID for a Tool (in the left-hand tree), then click on View. 

2) Select the Test Results you want to view Statistics for by clicking on the first one then holding down shift 
and clicking on the last one you wish to analyse. Use CTRL + A to select all results. 

 

3) Right click on the Test Results window and click on View Statistics on the drop-down menu. 
Alternatively click the        icon on the TDS Toolbar. 
 
NOTE:  All results 

must share 
the same 
Target, 
otherwise 
you will see 
the following 
pop up. 
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4) Right click on the statistics results and click on either View Histogram – Torque, View Histogram – 
Angle or Print. 

 

 
 
 

 
SPC Calculations 
 

Term Mathematical equation Comment 
Mean Sum of results / N This is the average result. 

Maximum  The largest result. 
Minimum  The smallest result. 

No readings  The number of readings 

Sigma The square root of: 
Σ(reading-mean)² / (N-1) 

Also known as standard deviation, this shows how close 
together the readings are. 

Cp (3 sigma) (USL – LSL) / 6 sigma 
This is the capability index, showing the process capability 
potential. It takes no account of how centred the process is. 

A value of 1.33 or more is desirable. 

Cpk (3 Sigma) 

lesser of: 
(USL-mean) / 3 sigma 

or 
(mean – LSL) / 3 sigma 

This indicates whether the process will produce units within 
tolerance. 

If the process is centred on the nominal value then Cpk will 
have a value equal to Cp. 

A negative value shows mean is outside tolerance. 
A value of 1.33 or more is desirable. 

Cp (6 sigma) (USL – LSL) / 12 sigma This is the capability index, showing the process capability 
potential. It takes no account of how centred the process is. 

Cpk (6 Sigma) 

lesser of: 
(USL-mean) / 6 sigma 

or 
(mean – LSL) / 6 sigma 

This indicates whether the process will produce units within 
tolerance. 

If the process is centred on the nominal value then Cpk will 
have a value equal to Cp. 

A negative value shows mean is outside tolerance. 
 
NOTE:  USL=Upper set limit 
 LSL=Lower set limit 
 N=Number of results 
 
The SPC calculations depend on the number of results selected and if a Target with limits was used. 
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View Histogram(s) 
 
1) Right Click on a Work ID for a Tool in the left-hand tree, then click on View from the drop-down menu. 

 
2) Select the Test Results you want to view Histogram for by clicking on the first one then holding down 

shift and clicking on the last one you wish to analyse. Use CTRL + A to select all. 
 

 
 
3) Right click on the Test Results window and  click on View Histogram – Torque or View Histogram – 

Angle from the drop-down menu. Alternatively click the       icon on the TDS Toolbar to view Torque 
Histogram only. 
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4) Right click on the Histogram to show Print or copy to Clipboard and click the required option.  

 
NOTE:  Export Data is not available for Histograms. 
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View Graph 
 
1) Click on a Work ID for a Tool in the left-hand pane and click on View. 

 
2) Select the Test Results you want to view Graph for by clicking on the first one then holding down shift 

and clicking on the last one you wish to analyse. Use CTRL + A to select all. 
 

 
 
3) Right click on the Test Results window and click on View Graph. 

 

 
 

4) Right click on the graph to show a drop down where you can select View as Torque v Angle, Print, 
Copy to Clipboard or Export Data. 
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View Report 
 

1) Click on a Work ID for a Tool in the left-hand pane and click on View. 
 

2) Select the Test Results you want to Create a Report from by clicking on the first one then holding down 
shift and clicking on the last one you wish to analyse. Use CTRL + A to select all. 
 

 
 
3) Right click on the Test Results window and click on View Report. Click on the Report to make it larger 

when this icon  is shown. Press ‘Ctrl’ + click to make it smaller. 
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Report Options 
 

Right click on the Report to show a drop-down below. 
 

 
 
Print Report 

 
Selecting Print will send the current 
Report to the Printer specified. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select Report Language 
 

Use this to select the language the Report is to 
be printed in. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Set Printer Margins 
 

See Set Printer Margins on Page 60 for more information. 
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Copy to Clipboard 
 

This function is used to copy and paste Graphs, Histograms and Reports into Microsoft applications like 
Word®, Excel® etc.  

 
 

Show Date or Date & Time 
 

When Show Time is ticked, Date & Time of 
Results will be added to the Report (instead 
of Date only). 
 
 

 
 
 
 
 
 
 
 
 

Change Report Logo 
 

This is used to specify 
the logo that is printed 
on Reports. 
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Set Tool Options 
 

All of the user configurable Setup options on the Tool 
can be configured and downloaded to the Tool from 
TDS.  

 
 

1. Right click on the required Tool and then click on 
Set Tool Options on the drop-down menu. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Alternatively, Click the Options tab followed by Set Tool 

Options. 
 
 
 
 
 
 
 
 

 
2.1. Select the Tool you wish to change 

the configuration by selecting in the 
Send To window. 
 
NOTE:  Only Tools that are 

connected will be 
shown.  

 
2.2. Tool Version - this is the current 

software version fitted to the selected 
Tool. 
 

2.3. Tool Capacity - this is the current 
Torque Capacity of the selected Tool. 
 

2.4. Last Cal Check Date – this is the 
date the calibration of the selected 
Tool was last altered. 
 

2.5. Choose the Display Unit you would 
like the Tool to work in by clicking in 
the tick box next to the required Unit. 
Only one unit is selectable at any one 
time. i.e. if you only want the Tool to 
operate in N·m, tick the N·m box. 
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2.6. Tick Auto Zero? if you wish the Tool to auto zero when the batteries are changed and every time the 
Tool resumes from sleep. 
 

2.7. Tick Vibrate? If you wish the Tool to vibrate when the Target on the Tool has been achieved. 
 

2.8. Tick Angle? If you wish the Tool to operate in Torque & Angle mode. If this box is not selected the 
Tool will operate in Torque only mode. 
 

2.9. Tick Auto Reset? If you wish the Tool to automatically reset after a Peak has been reached and the 
Torque is released. This operates in conjunction with the Hold Time setting detailed later.  
 
If this option is left un-ticked the NorTronic® operates in Manual Reset mode i.e. a Peak is held until 

the  button has been pressed on the NorTronic® Tool. 
 

2.10. By ticking Inverse? the display colours change from white on black to Black on white.  
 

NOTE:  This will result in significantly higher battery consumption. 
 

2.11. Tick Wireless? to enable wireless communication with TDS via the wireless adapter. 
 

2.12. Tick Complete Screen? To enable the NorTronic® to show the ‘Complete Screen’ when the ‘Number 
of Readings’ specified for a Target is larger than 1 and the results have been completed. 
 

2.13. Tick Warnings Screen? To enable the NorTronic® to show the ‘Warnings Screen’ when the ‘Torque 
CRS’ and/or ‘Multiplier’ values have been changed from their default values. This screen will be 
shown on power up or resume from sleep. 
 

2.14. The Hold Time value is the length of time a peak is held for before resetting to the current torque 
input. This is greyed out if Auto Reset? Is left un-ticked. 
 

2.15. The Sleep After value is the length of time the NorTronic® has been inactive before going into Sleep 
mode. 
 

2.16. The Active from threshold is the percentage of the Tool capacity that the Torque value must reach 
before a peak is held. Below this value the NorTronic® is in Track mode. 
 

2.17. Select the Date Format required by clicking on the selection box. Available formats are DD/MM/YY, 
MM/DD/YY or YY/MM/DD. 
 

2.18. The Torque CRS value only needs to be changed if the end fitting is changed.  
 

NOTE:  This value is to compensate for the error induced by fitting a different offset with say 
a 100 mm Torque Centres (CRS) so that the NorTronic® displays the correct Torque 
Value. 
 

2.19. The Multiplier setting ensures the NorTronic® displays the correct output Torque when used in 
conjunction with a Torque Multiplier: - i.e. with a 100:1 Ratio. 
 

2.20. The Wireless Node Number is to enable multiple NorTronic® Tools to be connected to TDS at the 
same time via the Norbar Wireless Adapter.  

 
NOTE:  This value must be different for all simultaneously connected NorTronic® Tools. As 

default all Tools shipped from Norbar will have the node number set as “2”, so if you 
have 2 Tools – set one of them to “2” and the other to “3” etc. 
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Lock NorTronic® Tool 
 
3. When the Locked option is ticked and downloaded to the NorTronic®, no Setup options or Target 

adjustments can be made by the user on the NorTronic® Tool. To enable Tool adjustment, un-tick the 
Locked option and download to the NorTronic® Tool. 

 
 
Update Settings on NorTronic® Tool 
 
4. Click the Update button to send the 

Tool Options to the NorTronic® Tool.  
 
 
 
 
You will see this message if the update has been 
successful.  
 
 

5. Click Done to close Set Tool Options and return to the TDS 
main screen. 
 
 

 
 

6. If the Tool was not updated you will see this 
message. This can be caused by the 
NorTronic® going to sleep.  
 
Click OK, wake the Tool and click the Update 
button again. 

 
 
 
 
 
 
Set Track Mode 
 
7. Click on Set Track Mode to disable peak mode and remain in Track mode up to 120% of the Tools 

capacity.  
 
NOTE:  This function can be used for ‘As Found’ Tool calibration. 

 
Restore Defaults 
 
8. Click on Restore Defaults to return the connected NorTronic® Tool to factory settings. 
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Erase Targets on Tool 
 
Targets can be removed from the NorTronic® Tool to using the ‘Erase Targets on Tool’ option.  
 
 
1) Right Click on the connected Tool (shown in 

blue) to show the drop-down menu. click on 
Erase Targets on Tool. 
 
 
 
 
 

2) You will see the following confirmation. 
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Capture Graph 
 

This allows the user to take and save a Torque (or Torque & Angle) graph in real time. 
 
NOTE:  This function is only enabled for a USB connected Tool. 
 
1) Right Click on the connected Tool (shown in 

blue) to show the drop-down menu. click on 
Capture Graph. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2) Type in required Text into the Notes 
entry box and click Start.  
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3) When you apply Torque 
above the Active from 
Threshold, the USB icon 
on the Tool will go blue 

 .  
 
 
If there is a Target on the 
Tool, this will be populated 
in the Target boxes. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4) Click Stop when you have finished taking the Graph. 
 
5) Click Show Captured Graph to view the graph just taken instantly, or alternatively click Finished to exit 

Capture Graph mode. 
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6) Graphs are saved under the Tool 

serial number in Graph Data. Each 
graph is identified by the Notes 
added before taking the graph and 
the Date – Time at which the graph 
was taken. 
 

7) Right Click on a graph (or double 
click to select View. Right click to 
select Delete Graph. 
 
 
 
 
 
 
 
 
 

Graph Options 
 
When Viewing a Graph, right click on the 
Graph to bring up the View Graph 
Options. 
 
 
 
 
 
 
 
 
 
 
The Graph can be viewed as either 
Torque/Angle v Time or Torque v Angle. 
Tick required option. 
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Show Limit Lines  
 
If a Target was used, Click on Show Limit Lines to view on the graph (Angle in blue and Torque in red). 
Tick to enable. 

 

 
 
Show Limit Brackets  
 
If a Target was used, Click on Show Limit Brackets to view on the graph. These are shown in black for 
Torque only. Tick to enable. 

 

 
 
Show Turns  
 
Click on Show Turns to show a Torque & Angle graph as Torque and Turns.   
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Hide Leading Zeros  
 
NOTE: Not available for the NorTronic® and will always be greyed out. 
 
 
Print  
 
Send the currently 
displayed graph to a 
printer.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Copy to Clipboard  
 
This function is used to copy and paste Graphs, Histograms and Reports into Microsoft applications like 
Word®, Excel® etc.  
 
 
Export Data  
 

This allows the Graph 
data to be saved as a 
CSV file. 
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Notes 
 

Here is where you can 
name the Graph or edit a 
previously given name. 
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Tool Content 
 

This shows the current Target or Targets on the 
NorTronic® Tool along with the current Work ID. 

 
 
 
 
 
 

1) Right click on the required Tool in the tree view, 
then click on Tool Content on the drop-down 
menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2) The pop up will show the 
current Target(s) & Work ID 
on the Tool. 
 
This picture shows 11 
standalone (non-linked) 
Targets with a Work ID “NOT 
LINKED”. If the first column 
says “Target #”, the Targets 
are not linked to each other. 
 
The currently selected Target 
on the Tool is shown at the 
bottom. 
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3) If the Targets are linked, the 

first Column will say “# 
Linked”. 
 
 
The Targets are processed in 
the order they appear in the 
‘Tool Content’ pop up. 
 
 
The currently selected Target 
on the Tool is shown at the 
bottom. 
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Reset Test Data Read Index 
 
This option is Tool specific 
 
This should only be selected if you are experiencing loss of data transfer between the NorTronic® and TDS 
using either USB or Wireless synchronization. 

 

 
 
 

 
 

 
Every piece of test data NorTronic® stores has a unique ID in increasing values. So that only the latest data 
is transferred, TDS only requests test values with an ID greater than the one it last read for that NorTronic® 
serial number. When you do a ‘Reset Test Data Read Index’, TDS sets this read ID to zero for that Tool, so 
all test data is transferred on the next Sync. However, it also stores the test ID and won't duplicate data it 
already has stored. 
 
TIP:  If you have already synchronized NorTronic® to TDS and select Reset Test Data Read Index, 

the next time that you synchronize with TDS, some data may be duplicated. 
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Options 
 
USB / Wireless Synchronization Options 
 
1) Right click on Options on the TDS Toolbar  

 
NOTE:  A Tool must be connected via USB/Wireless 

and TDS must be displaying “X Tool is 
Present (XXXXXX)” in the bottom left hand 
corner).  
 

2) Click Automatic Synchronization on the drop-down menu to turn on (ticked). Click again to turn it off 
(un-ticked). 
 
When Automatic Synchronization is turned On, Test Results are uploaded from NorTronic® to TDS 
and the current time / date is set on the NorTronic® when the Tool has been detected by TDS. 
 

 When Automatic Synchronization is turned Off, you can use the Synchronize Now by clicking the  
 icon on the TDS Toolbar or licking on the option from the drop down menu to control when Test 
Results are sent to TDS.  

 

 
 
 
Synchronize Now 
 
Right click on Synchronize Now on the TDS Toolbar. 
 

 
 

 

Synchronize Now receives any stored results from any connected NorTronic® Tool (single or multiple) into 
TDS. 
 
This option is used to control the data sent and received from each NorTronic® (i.e. Tool Setup, Test Results 
(Work ID). The current time / date on the NorTronic® Tool is also synchronized with the PC. 
 
NOTE:  This option is only active when ‘X Tool is present 

(XXXXXX)’ is shown in the bottom left hand 
corner of TDS after connecting to a NorTronic® 
Tool(s) via USB or Wireless. 
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Set Printer Margins 
 
To ensure compatibility with different printers where printouts of reports do not fit on the page: 

 
1) Click the Options tab. 

 
2) Click Set Printer Margins. 

 

 
 
3) Click in each box and type in desired value. 
 

 
 
 
 
 

DATABASE 
 
Backup Database 
 
All data can be backed up to a location specified by clicking Database 
and then clicking Backup. Type in the backup file name and click Save.  

 
 

Restore Database 
 
Data can be restored from that location by clicking Database and then 
clicking Restore, select the backup file and then click Open. 
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View 
 

Click Refresh to redraw the current window. 
 
• The User can print data in the right-hand 

pane using Print by highlighting the required 
data. 

 
• Copy the data in the right-hand pane and 

paste into another application such as 
Microsoft® Excel® or Word® etc using Copy 
to Clipboard by highlighting the required 
data. 
 
 

 

Window Options 
 
Click the Window tab on the TDS Toolbar, and then click on the desired window option. These options are 
intended for use when multiple windows are open so that they can be viewed simultaneously. These options 
can also be selected directly from the TDS Toolbar. 

 

 
 
 
Currently Open Windows 

 
This is shown on the bottom right of TDS. 
 
Click on icon to go to currently open window. 
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Collapse to 1st level 
 
Right Click on the root of the tree (Departments) to contract 
the tree view to the ‘Department’ level (as seen in the 
second picture below). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
About TDS 
 
Click on the information icon on the TDS shortcut bar. 
 
This will show the version 
number of the software. 
 

 
 
 
 
 
 
 
 
 
Click OK to cancel. 
 
 
 
Click Database File… to show where the TDS database is stored. 
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Key to Shortcut Icons 
 

These can be used for quick selection from the shortcut bar. 
 

Icon Shortcut to 

 Add Tool 

 Delete Tool 

 Define Targets (Ctrl+G) 

 Add Target 

 Modify Target 

 Delete Target 

 Duplicate Target 

 Cut Test Result Data 

 Copy Test Result Data 

 Paste Test Result Data 

 Delete Test Result Data 

 Rename 

 Reset Column Sizes 

 Find 

 Synchronise Now 

 Send Target 

 View Statistics 

 View Graph 

 View Histogram 

 Refresh (F5) 

 Copy to Clipboard 

 Print 

 Export Data 

 Notes 

 Properties - Settings 

 Cascade Windows 

 Tile Windows Horizontally 

 Tile Windows Vertically 

 Arrange Iconized Windows 

 Close All Windows 

 Set Printer Margins 

 About TDS 

 Exit TDS 

 Operator’s Manual 
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Trouble Shooting 
 

Problem Likely Solutions 

TDS displays 0 Tools 
are present and will 
NOT synchronize with 
NorTronic®. 
USB connection. 

a)  Unplug the USB lead, wait at least 10 seconds and re-insert whilst TDS has 
been launched and NorTronic® is displaying the Measure screen (Hot-Plug). 

b)  Ensure that you disconnect from USB correctly before removing the lead. 
Click on ‘Safely Remove Hardware’ in the bottom right hand corner of your 
desktop if this option is available to you.  

TDS displays 0 Tools 
are present and will 
NOT synchronize with 
NorTronic®. 
Wireless 
connection. 

a)  Ensure the correct frequency wireless adapter is plugged in. 
b)  Ensure the NorTronic® Tool has the correct frequency Transceiver fitted. 
c)  Ensure the Wireless interface has been set up correctly. See the Wireless 

Setup section in NorTronic® Manual part # 34399. 

Data does not 
transfer between 
NorTronic® and TDS 

a)  After installing new NorTronic® software and perhaps TDS software, if you 
restore an earlier backup of TDS and then take some new data on the 
NorTronic®, the data will NOT get transferred to TDS.  

 You will have to use “Reset Test Data Read Index” before synchronizing. 
b)  The user must wait at least 10 seconds after saving the last result to the 

Tool and synchronizing with TDS. 

Searching for the 
Work ID “none” 

When searching for the Work ID “none”, you must enter the greater than & less 
than arrows before and after i.e. <none> 

Multiple Tools will not 
connect 

a)  Ensure the Tools have individual node numbers. See Wireless Setup in 
NorTronic® Manual part # 34399. 

b)  Ensure TDS has recognised the 1st Tool before trying to connect the 2nd etc 

NorTronic® Target & 
Setup cannot be 
accessed and beep 
when selected. 

The Lock option has been downloaded to the Tool from TDS. To allow Target 
and Setup changes to be made on the Tool, start ‘TDS’ and then un-tick the 
‘Lock’ option on the ‘Set Tool Options’ screen and click ‘Update’. 
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Uninstalling TDS 
 
Windows® 7, 8.1 & 10 
 
 

 
 
Go to Control Panel – Add or 
Remove Programs – Select 
Norbar TDS version 2.X.X – 
Click ‘Uninstall’ and then click 
‘Yes’ to confirm you want to 
un-install TDS. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Click OK.  
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